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About This Book

WARNING! Text set off in this manner indicates that failure to follow directions could result in bodily
harm or loss of life.

CAUTION: Text set off in this manner indicates that failure to follow directions could result in damage
to equipment or loss of information.

NOTE: Text set off in this manner provides important supplemental information.
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1 Product features

Front panel components
For more information, go to http://www.hp.com and search for your specific thin client model to find
the model-specific QuickSpecs.

(1) Power button (4) USB 3.0 ports (2)

(2) Flash drive activity LED (5) Microphone port

(3) USB 2.0 ports (2) (6) Headphone port

Front panel components 1
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Rear panel components
For more information, go to http://www.hp.com and search for your specific thin client model to find
the model-specific QuickSpecs.

(1) Half-height PCIe 2.0 expansion slot* (8) PS/2 keyboard port

(2) Serial port* (9) PS/2 mouse port

(3) Parallel port* (10) Serial port

Optional: VGA port or fiber NIC port

(4) Retractable power cord retention hook (11) Audio line-in port

(5) Ethernet RJ-45 port (12) Audio line-out port

(6) USB 2.0 ports (2) (13) Power

(7) Dual-mode DisplayPort 1.2 ports (2) (14) Cable lock slot and rear cover latch

*Available on some models. Refer to the model-specific QuickSpecs at www.hp.com for details.

If the configurable port (item #10) is VGA, then the devices connected at boot up or subsequently
disconnected determine which video ports are enabled and which is disabled.

● If a VGA device is connected at boot up, then only one DisplayPort port may be used. If the VGA
device is subsequently disconnected, then both DisplayPort ports are enabled.

● If a VGA device and one DisplayPort device are connected at boot up, then the other DisplayPort
port is disabled. If the VGA device is subsequently disconnected, then that DisplayPort port is
enabled.

● If two DisplayPort devices are connected at boot up, then the VGA port is disabled. If one or both
DisplayPort devices are subsequently disconnected, the VGA port is enabled.
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Presence of an optional VGA or Fiber NIC port does not disable a DisplayPort port.

Serial number location
Every thin client includes a unique serial number located as shown in the following illustration. Have
this number available when contacting HP customer service for assistance.
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2 Hardware changes

Warnings and cautions
Before performing upgrades be sure to carefully read all of the applicable instructions, cautions, and
warnings in this guide.

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot
surfaces, or fire:

Disconnect the power cord from the power outlet and allow the internal system components to cool
before you touch them.

Do not plug telecommunications or telephone connectors into the network interface controller (NIC)
receptacles.

Do not disable the power cord grounding plug. The grounding plug is an important safety feature.

Plug the power cord into a grounded (earthed) outlet that is easily accessible at all times.

To reduce the risk of serious injury, read the Safety & Comfort Guide. It describes proper workstation,
setup, posture, and health and work habits for computer users, and provides important electrical and
mechanical safety information. The Safety & Comfort Guide is located on the HP website at
http://www.hp.com/ergo.

WARNING! Energized and moving parts inside.

Disconnect power to the equipment before removing the enclosure.

Replace and secure the enclosure before re-energizing the equipment.

CAUTION: Static electricity can damage the electrical components of the computer or optional
equipment. Before beginning the following procedures, be sure that you are discharged of static
electricity by briefly touching a grounded metal object.

When the computer is plugged into an AC power source, voltage is always applied to the system
board. To prevent damage to internal components, you must disconnect the power cord from the power
source before opening the computer.
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Connecting the power cord
1. Plug the female end of the power cord into the power supply brick (1).

2. Connect the other end of the power cord to an electrical outlet (2).

3. Connect the round end of the power supply cord to the power supply connector on the rear of the
computer (3).

4. Use the slot (4) on the side of the retractable power cord retention hook to pull the hook out.

5. Press the power cord into the retention hook (5) and bundle any excess power cord.

CAUTION: Failure to secure the power cable with the retention hook may result in the power cord
becoming disconnected, causing loss of data.

Connecting the power cord 5



Attaching the stand
CAUTION: The computer must be operated with the stand attached to ensure proper airflow around
the computer.

The computer can be used in either a tower or horizontal orientation with the stand included with the
computer.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, and then turn off any external
devices.

4. Disconnect the power cord from the power outlet and disconnect any external devices.

5. Attach the stand to the computer.

● Attach the stand to the bottom of the computer to use the computer in the tower orientation.

a. Turn the computer upside down and locate the two screw holes in the grid on the bottom
of the computer.

b. Position the stand (1) over the bottom of the computer and line up the captive
thumbscrews in the stand with the screw holes in the computer.

c. Tighten the captive thumbscrews (2) securely.
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● Attach the stand to the right side of the computer to use it in the horizontal orientation.

a. Lay the computer down with the right side up and locate the two screw holes in the grid
on the right side of the computer.

b. Position the stand (1) over the side of the computer and line up the captive thumbscrews
in the stand with the screw holes in the computer.

c. Tighten the captive thumbscrews (2) securely.

6. Reconnect the external equipment, plug the power cord into a power outlet, and then turn the
computer on.

NOTE: Be sure that at least 10.2 centimeters (4 inches) of space on all sides of the computer
remain clear and free of obstructions.

NOTE: An optional Quick Release mounting bracket is available from HP for mounting the computer
to a wall, desk, or swing arm. When the mounting bracket is used, do not install the computer with the
I/O ports oriented towards the ground.
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Removing and replacing the access panel

Removing the access panel

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot
surfaces, or fire, ALWAYS operate the computer with the access panel in place. In addition to
enhancing safety, the access panel may provide important instructions and identification information,
which may be lost if the access panel is not used. DO NOT use any access panel except the one that is
provided by HP for use with this computer.

Before removing the side access panel, be sure that the thin client is turned off and the power cord is
disconnected from the electrical outlet.

To remove the access panel:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, and then turn off any external
devices.

4. Disconnect the power cord from the power outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5. Remove the computer from the stand.

6. Lay the unit flat on a stable surface with the right side up.

7. Release the latch (1) on the left side of the rear I/O panel, rotate the I/O panel (2) to the right,
and then lift it off the computer.
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8. Move the access panel latch (1) to the left to release the access panel.

9. Slide the access panel (2) approximately 6 cm (.24 in) toward the back of the chassis, and then
lift the panel off of the computer.

Replacing the access panel

To replace the access panel:

1. Set the access panel (1) onto the chassis approximately 6 cm (.24 in) inside the edge of the
chassis, and then slide the panel toward the front of the chassis until it locks in place.

2. Move the access panel latch (2) to the right to secure the access panel.
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3. Insert the hooks on the right side of the I/O panel (1) into the right side of the back of the chassis,
and then press the left side (2) to the chassis until it locks in place.
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Installing internal USB flash drives
There are two USB flash drive ports on the system board.

To install a USB flash drive:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, and then turn off any external
devices.

4. Disconnect the power cord from the power outlet, and disconnect any external devices.

5. Remove the computer from the stand and lay the computer down with the right side up.

6. Remove the computer access panel and back I/O panel. See Removing and replacing the access
panel on page 8.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before you touch them.

7. If the computer is an HP t620 PLUS Thin Client, push the fan assembly latch (1) toward the front of
the computer and rotate the assembly (2) up and out of the way.

8. Locate the USB flash drive ports on the system board.
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(1) USB-1 port

USB 2.0 flash drive: maximum dimensions 55 mm
(L) x 16 mm (W) x 8 mm (H)

(2) USB-2 port

USB 2.0 flash drive: maximum dimensions 65 mm
(L) x 25 mm (W) x 10 mm (H)

NOTE: Be sure that the USB flash drive to be installed does not exceed the maximum size for
that USB port.

9. Align the USB flash drive with the USB port and press the drive firmly into the port until it is
securely seated.

10. If the computer is an HP t620 PLUS Thin Client, rotate the fan assembly down, push the fan
assembly latch (1) toward the front of the computer, lower the assembly (2) until it stops, and then
release the latch.
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11. Replace and latch the access panel, and then reinstall the I/O panel.

12. Replace the computer stand.

13. Reconnect the power cord and turn on the computer.

14. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

Installing additional memory
The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3L-
SDRAM) small outline dual inline memory modules (SODIMMs).

SODIMMs

The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 16 GB of memory.

DDR3L-SDRAM SODIMMs

For proper system operation, the SODIMMs must adhere to the following specifications:

● industry-standard 204-pin

● unbuffered non-ECC PC3L-12800 DDR3L-1600 MHz-compliant

● 1.35 volt DDR3L-SDRAM SODIMMs

● support CAS latency 11 DDR3L 1600 MHz (11-11-11 timing)

● contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

The computer supports the following:

● 2 Gb and 4 Gb non-ECC memory technologies

● single-sided and double-sided SODIMMS

● SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

NOTE: The system does not operate properly when unsupported SODIMMs are installed.
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Populating SODIMM sockets

There are two SODIMM sockets on the system board with one total channel. The sockets are labeled
DIMM1 and DIMM2. The system operates in single-channel mode at 1600 MHz.

Item Description System Board Label Socket Color

1 SODIMM1 socket, Channel A DIMM1 Black

2 SODIMM2 socket, Channel A DIMM2 White

NOTE: If both SODIMM sockets are populated with dual-sided SODIMMs, the system memory speed
is reduced to 1333 MHz.
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Installing SODIMMs

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before
beginning the following procedures, be sure that you are discharged of static electricity by briefly
touching a grounded metal object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, and then turn off any external
devices.

4. Disconnect the power cord from the power outlet, and disconnect any external devices.

CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the
power to drain before adding or removing memory modules. Regardless of the power-on state,
voltage is always supplied to the memory modules as long as the computer is plugged into an
active AC outlet. Adding or removing memory modules while voltage is present may cause
irreparable damage to the memory modules or system board.

5. Remove the computer from the stand and lay the computer down with the right side up.

6. Remove the computer access panel and back I/O panel. See Removing and replacing the access
panel on page 8.

WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before you touch them.
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7. If the computer is an HP t620 PLUS Thin Client, push the fan assembly latch (1) toward the front of
the computer and rotate the assembly (2) up and out of the way.

8. Locate the memory compartment on the system board.

9. If a fiber NIC is installed, move the cable carefully out of the slot in the memory compartment
cover.
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10. Remove the two screws and springs (1) securing the memory compartment cover.

NOTE: Be sure to retain the two screws and the springs beneath them.

11. Slide the memory compartment cover (2) slightly toward the front of the computer to free it, and
then lift it out of the chassis.

12. To remove a SODIMM, press outward on the two latches (1) on each side of the SODIMM, rotate
the SODIMM up (2), and then pull the SODIMM out of the socket (3).

Installing additional memory 17



13. Slide the new SODIMM (1) into the socket at approximately a 30° angle, and then press the
SODIMM into the socket (2) so that the latches lock it in place.

NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.

14. Hold the memory compartment cover with the fiber NIC slot toward the front of the computer, and
then set the memory compartment cover (1) over the SODIMMs.

15. If a fiber NIC is installed, move the cable carefully into the slot in the memory compartment cover.

16. Line up the screw holes in the memory cover with the screw posts in the chassis, and then fasten
the two screws (2) with the springs to secure the memory compartment cover.
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17. If the computer is an HP t620 PLUS Thin Client, rotate the fan assembly down, push the fan
assembly latch (1) toward the front of the computer, lower the assembly (2) until it stops, and then
release the latch.

18. Replace and latch the access panel, and then reinstall the I/O panel.

19. Replace the computer stand.

20. Reconnect the power cord and turn on the computer.

21. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

The computer automatically recognizes the additional memory when you turn on the computer.

Installing additional memory 19



Installing a PCI-Express card
You may install an optional half-height PCI-Express (PCIe) card in the HP t620 PLUS Thin Client. A riser
card is installed in this computer by default.

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot
surfaces, or fire, disconnect the power cord from the power outlet and allow the internal system
components to cool before you touch them.

To install a PCIe card:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, and then turn off any external
devices.

4. Disconnect the power cord from the power outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5. Remove the computer from the stand and lay the computer down with the right side up.

6. Remove the computer access panel and back I/O panel. See Removing and replacing the access
panel on page 8.

7. Push the fan assembly latch (1) toward the front of the computer and rotate the assembly (2) up
and out of the way.
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8. Locate the slot in the riser card.

9. Slide the expansion slot cover left and remove it.
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10. Align the PCIe card connectors with the slot in the riser card and the metal tab at the end of the
card with the slot in the chassis. Press the PCIe card firmly into the slot in the riser card until it is
securely seated and the tab is in the slot.

11. Rotate the fan assembly down, push the fan assembly latch (1) toward the front of the computer,
lower the assembly (2) until it stops, and then release the latch.

12. Replace and latch the access panel, and then reinstall the I/O panel.

13. Replace the computer stand.

14. Reconnect the power cord and turn on the computer.

15. Lock any security devices that were disengaged when the computer cover or access panel was
removed.
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Installing a half-height PCI-Express 2.0 card
You may install an optional half-height PCI-Express (PCIe) card in the HP t620 PLUS Thin Client. A riser
card is installed in this computer by default.

WARNING! To reduce the risk of personal injury or equipment damage from electric shock, hot
surfaces, or fire, disconnect the power cord from the power outlet and allow the internal system
components to cool before you touch them.

To install a PCIe card:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, and then turn off any external
devices.

4. Disconnect the power cord from the power outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5. Remove the computer from the stand and lay the computer down with the right side up.

6. Remove the computer access panel and back I/O panel. See Removing and replacing the access
panel on page 8.

7. Push the fan assembly latch (1) toward the front of the computer and rotate the assembly (2) up
and out of the way.
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8. Locate the slot in the riser card.

9. Slide the expansion slot cover left and remove it.
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10. Align the PCIe card connectors with the slot in the riser card and the metal tab at the end of the
card with the slot in the chassis. Press the PCIe card firmly into the slot in the riser card until it is
securely seated and the tab is in the slot.

11. Rotate the fan assembly down, push the fan assembly latch (1) toward the front of the computer,
lower the assembly (2) until it stops, and then release the latch.

12. Replace and latch the access panel, and then reinstall the I/O panel.

13. Replace the computer stand.

14. Reconnect the power cord and turn on the computer.

15. Lock any security devices that were disengaged when the computer cover or access panel was
removed.
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Security
The thin client is equipped with a hood sensor. You may also use a cable lock to secure the computer.

For an additional layer of security, you may purchase a port cover to prevent unauthorized access to
the rear ports.

Hood sensor

The hood sensor is a combination of hardware and software technology. If the access panel is
removed, the hood sensor is released and the computer alerts local users to tampering or removal of
the access panel.

26 Chapter 2   Hardware changes



Cable lock

These thin clients are designed to accept a security cable lock. This cable lock prevents unauthorized
removal of the thin client, as well as locking devices installed inside the case. To order this option, visit
the HP website at http://www.hp.com and search for your specific thin client model.

1. Locate the cable lock slot on the back panel.

2. Insert the cable lock into the slot, and then use the key to lock it.

Security 27
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Removing and replacing the battery
WARNING! Before removing the side access panel, be sure that the thin client is turned off and the
power cord is disconnected from the electrical outlet.

To remove and replace the battery:

1. Remove/disengage any security devices that prohibit opening the computer.

2. Remove all removable media, such as USB flash drives, from the computer.

3. Turn off the computer properly through the operating system, and then turn off any external
devices.

4. Disconnect the power cord from the power outlet, and disconnect any external devices.

CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5. Remove the computer from the stand and lay the computer down with the right side up.

6. Remove the computer access panel and back I/O panel. See Removing and replacing the access
panel on page 8.

7. If the computer is an HP t620 PLUS Thin Client, perform the following steps:

a. Push the fan assembly latch (1) toward the front of the computer and rotate the assembly (2)
up and out of the way.

b. If a PCIe card is installed, remove it carefully.
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c. Pull the riser card out of the socket and carefully move it to one side.

Disconnecting the cables from the PCIe riser card is not necessary.

8. Locate the battery on the system board.

9. Carefully pry the battery up from the system board.

10. Unplug the battery cable connector from the system board.

11. Connect the cable connector from the new battery to the system board.

12. Carefully press the new battery down to adhere the battery securely to the system board.

13. If the computer is an HP t620 PLUS Thin Client, perform the following steps.

a. If the cables from the PCIe riser card were disconnected in step 7 c, reconnect them.
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b. Align the riser card with the socket on the system board and press the riser card firm into the
socket.

NOTE: The riser card can be installed in only one way. Match the notch on the card with
the tab on the socket.

c. If a PCIe card was installed, reinstall it. For instructions, see Installing a PCI-Express card
on page 20.

d. Rotate the fan assembly down, push the fan assembly latch (1) toward the front of the
computer, lower the assembly (2) until it stops, and then release the latch.

14. Replace and latch the access panel, and then reinstall the I/O panel.

15. Replace the computer stand.
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16. Reconnect the power cord and turn on the computer.

17. Lock any security devices that were disengaged when the computer cover or access panel was
removed.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com and
search for “recycle”.

Batteries, battery packs, and accumulators should not be disposed of together with the general household
waste. In order to forward them to recycling or proper disposal, please use the public collection system or
return them to HP, an authorized HP partner, or their agents.

The Taiwan EPA requires dry battery manufacturing or importing firms, in accordance with Article 15 or
the Waste Disposal Act, to indicate the recovery marks on the batteries used in sales, giveaways, or
promotions. Contact a qualified Taiwanese recycler for proper battery disposal.
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A Computer Setup (F10) Utility, BIOS
Settings

Computer Setup (F10) Utilities
Use Computer Setup (F10) Utility to do the following:

● Change factory default settings.

● Set the system date and time.

● Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

● Modify the boot order of bootable devices such as solid-state drives or USB flash media devices.

● Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

● Enter the Asset Tag or property identification number assigned by the company to this computer.

● Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

● Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

● Secure integrated I/O functionality, including the USB, audio, or embedded NIC, so that they
cannot be used until they are unsecured.
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Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:

1. Turn on or restart the computer.

2. Press either Esc or F10 while the “Press the ESC key for Startup Menu” message is displayed at the
bottom of the screen.

Pressing Esc displays a menu that allows you to access different options available at startup.

NOTE: If you do not press Esc or F10 at the appropriate time, you must restart the computer and
again press Esc or F10 when the monitor light turns green to access the utility.

NOTE: You can select the language for most menus, settings, and messages using the Language
Selection option using the F8 key in Computer Setup.

3. If you pressed Esc, press F10 to enter Computer Setup.

4. A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

5. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

6. To apply and save changes, select File > Save Changes and Exit.

● If you have made changes that you do not want applied, select Ignore Changes and
Exit.

● To reset to factory settings, select Apply Defaults and Exit. This option will restore the
original factory system defaults.

CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only after
exiting the F10 Setup screen.

Heading Table

File Computer Setup—File on page 34

Storage Computer Setup—Storage on page 35

Security Computer Setup—Security on page 36

Power Computer Setup—Power on page 38

Advanced Computer Setup—Advanced on page 38
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Computer Setup—File

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Option Description

System Information Lists:

● Manufacturer

● Product name

● SKU number (some models)

● Serial number

● Asset Tag

● System Board ID

● Product Configuration ID

● System Board CT Number

● BIOS Revision

● BIOS Date

● Processor type

● Processor speed

● Installed memory size/speed, number of channels (single or dual) (if applicable)

About Displays copyright notice.

Set Time and Date Allows you to set system time and date.

Apply Defaults and
Exit

Loads the original factory system configuration settings for use by a subsequent “Apply Defaults and
Exit” action.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.
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Computer Setup—Storage

Option Description

Device
Configuration

Lists all installed BIOS-controlled storage devices. When a device is selected, detailed information
and options are displayed. The following options may be presented:

Hard Disk: Size, model, firmware version, serial number.

Storage Options SATA Emulation

CAUTION: SATA emulation changes may prevent access to existing drive data and degrade or
corrupt established volumes.

Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are two supported options: IDE and AHCI (default).

IDE - This is the most backwards-compatible setting of the three options. Operating systems usually
do not require additional driver support in IDE mode.

AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.

DPS Self-test Allows you to execute self-tests on ATA hard drives capable of performing the Drive Protection
System (DPS) self-tests.

NOTE: This selection will only appear when at least one drive capable of performing the DPS self
tests is attached to the system.

Boot Order Allows you to:

● Specify the order in which EFI boot sources (such as a internal drive, USB hard drive, or USB
optical drive) are checked for a bootable operating system image. Each device on the list may
be individually excluded from or included for consideration as a bootable operating system
source. EFI boot sources always have precedence over legacy boot sources.

● Specify the order in which legacy boot sources (such as a network interface card, internal
drive, or USB optical drive) are checked for a bootable operating system image. Each device
on the list may be individually excluded from or included for consideration as a bootable
operating system source.

● Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: You can use F5 to disable individual boot items, as well as disable EFI boot and/or
legacy boot.

MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-1  Computer Setup—Security

Option Description

Setup Password Allows you to set and enable a setup (administrator) password.

NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On
Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle or reboot. If the user does not enter the correct power-on password, the unit will not
boot.

Password Options

(This selection appears
only if a power-on
password or setup
password is set.)

Allows you to enable/disable:

Stringent Password: This item only selectable while Setup Password is set.

NOTE: Disable the on-board password jumper’s (E49) ability to reset the setup passwords.

When enabling Stringent Password, losing the passwords may render the system permanently
unusable.

Device Security Allows you to set Device Available/Device Hidden (default is Device Available) for:

● System audio

● Network controller

● SATA Port 0

● SATA Port 1

USB Security Allows you to set Enabled/Disabled (default is Enabled) for:

● Front USB Ports

◦ USB Port 3

◦ USB Port 4

◦ USB Port 8

◦ USB Port 9

● Rear USB Ports

◦ USB Port 0

◦ USB Port 1

● Accessory USB Ports

◦ USB Port 2

◦ USB Port 7
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Table A-1  Computer Setup—Security (continued)

Slot Security Allows you to disable the PCI Express slot and Mini Card Slot. Default is enabled.

● PCI Express x4 Slot #

● Mini Card Slot

Network Boot Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs Allows you to set:

● Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

● Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are used
to uniquely identify the system.)

System Security Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.

Virtualization Technology (enable/disable). Controls the virtualization features of the processor.
Changing this setting requires turning the computer off and then back on. Default is disabled.

Smart Cover Cover Removal Sensor (Disable/Notify User). Allows notification to user that the cover has been
opened.

Trusted Computing Allows you to configure the trust computing device.

● Security Device Support (Enabled/Disabled). Enable or Disable BIOS Support for security
devices. When Disabled, OS will not show Security Device; the TCG EFI protocol and INIT 1A
interface will not be available.

● TPM State (Enabled/Disabled). Enable or Disable Security Device.

NOTE: Your computer will reboot during restart in order to change state of the device.

● Pending operation (None/TPM Clear). Schedule an operation for the security device.

NOTE: Your computer will reboot during restart in order to change state of security device.

Secure Boot
Configuration

The options on this setup page are only for Windows 8 and other operating systems that support
Secure Boot. Changing the default setting of the setup options on this page for operating system that
do not support secure boot may prevent the system from booting successfully.

Legacy Support (Enable/Disable). Enable or disable the legacy operating system support (Windows
Embedded Standard 7 and HP Thin-Pro).

Secure Boot (Enable/Disable). Only when the Legacy Support set to “Disable”, this item can be set
to Enabled. This item is for Secure Boot flow control. Secure boot is possible only if system run in
user mode.

Key Management

● Clear Secure Boot Keys (Clear/Don’t Clear). Lets you clear the Secure Boot Key.

● Key ownership (HP keys/ Customer keys). Lets you change the keys of different owners.

Fast Boot (Enable/Disable). Enable Fast Boot cause system boot by initializing a minimal set of
devices which is required to launch active boot option. This option has no effect for BBS boot
options.
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Computer Setup—Power

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-2  Computer Setup—Power

Option Description

Hardware Power
Management

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.

S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.

S4/S5 Wake on LAN (Disable/Enable). Permits the user to control whether the system should wake
from S4 of S5 if a magic packet id received by NIC.

Thermal CPU Fan speed (Read-Only), show the CPU fan speed in RPM on the t620 Flex system.

Computer Setup—Advanced

NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.

Table A-3  Computer Setup—Advanced (for advanced users)

Option Heading

Power-On Options Allows you to set:

● POST messages (enable/disable). Default is disabled.

● After Power Loss (off/on/previous state). Default is Power off. Setting this option to:

◦ Power off—causes the computer to remain powered off when power is restored.

◦ Power on—causes the computer to power on automatically as soon as power is restored.

◦ Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.

● POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST delay
also gives you more time to select F10 to enter Computer (F10) Setup. Default is None.

BIOS Power-On Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices Allows you to set resources for or disable Legacy devices.
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Table A-3  Computer Setup—Advanced (for advanced users) (continued)

Bus Options On some models, allows you to enable or disable:

● PCI SERR# Generation. Default is enabled.

● PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Device Options Allows you to set:

● Printer mode (Bi-Directional, EPP + ECP, Output Only). Default is EPP+ECP.

● Num Lock State at Power-On (off/on). Default is off.

● Integrated Graphics (Auto/Force). Use this option to manage integrated (UMA) graphics
memory allocation. The value you choose allocates memory permanently to graphics and is
unavailable to the operating system. For example, if you set this value to 512M on a system
with 2 GB of RAM, the system always allocates 512 MB for graphics and the other 1.5 GB for
use by the BIOS and operating system. Default is Auto which sets memory allocation to 512
MB.

If you select Force, the UMA Frame Buffer Size option displays, which lets you set the UMA
memory size allocation between 32 MB and 1 GB.

● Internal Speaker (some models) (does not affect external speakers). Default is enabled.

● Multi-Processor (Enable, Disable) Default Enabled; Use this option to disable multiprocessoe
support under the OS.

● NIC Option ROM Download (PXE, disabled). The BIOS contains an embedded NIC option
ROM to allow the unit to boot through the network to a PXE server. This is typically used to
download a corporate image to a hard drive. The NIC option ROM takes up memory space
below 1MB commonly referred to as DOS Compatibility Hole (DCH) space. This space is
limited. This F10 option will allow users to disable the downloading of this embedded NIC
option ROM thus giving more DCH space for additional PCI cards which may need option
ROM space. The default will be to have the NIC option-ROM-enabled. Default is PXE.
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Changing BIOS Settings from the HP BIOS Configure
Utility (HPBCU)

Some BIOS settings may be changed locally within the operating system without having to go through
the F10 utility1. This table identifies the items that can be controlled with this method.

BIOS Setting Default Value Other Values

Language English Francais, Espanol, Deutsch, Italiano, Dansk, Suomi, Nederlands,
Norsk, Portugues, Svenska, Japanese

Set Time 00:00 00:00:23:59

Set Day 01/01/2011 01/01/2011 to current date

Apply Defaults and Exit Disable Enable

SATA Emulation AHCI IDE

System Audio Device available Device hidden

Network Controller Device available Device hidden

SATA0 Device available Device hidden

SATA1 Device available Device hidden

Front USB Ports Enable Disable

Rear USB Ports Enable Disable

Internal USB Ports Enable Disable

Front USB Port 3, 4, 8, & 9 Enable Disable

Rear USB Port 0 & 1 Enable Disable

Internal USB Port 2 & 7 Enable Disable

PCI Express x4 Slot # Enable Disable

Mini Card Slot Enable Disable

Network Boot Enable Disable

Data Execution Prevention Enable Disable

Virtualization Technology Disable Enable

Trusted Computing Enable Disable

Legacy Support Enable Disable (Note: The default value may be varied depends on the
OS)

Secure Boot Disable Enable (Note: The default value may be varied depends on the OS)

Clear Secure Boot Keys Don’t Clear Clear

Key Ownership HP Keys Custom Keys

Fast Boot Disable Enable (Note: The default value may be varied depends on the OS)
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Smart Cover Disable Notify, User

SATA Power Management Enable Disable

S5 Maximum Power
Savings

Disable Enable

S4/S5 Wake on LAN Disable Enable

CPU Fan Check Enable Disable

POST Messages Disable Enable

After Power Loss Off On, Previous State

POST Delay (in seconds) None 5, 10, 15, 20, 60

Power on Sunday –
Saturday

Disable Enable

Power on Time (hh:mm) 00:00 00:00:23:59

Serial Port A IO=3F8; IRQ=4 Disable, IO=3F8h; IRQ=3, IO=2F8h; IRQ=4, IO=2F8h; IRQ=3,
IO=3E8h; IRQ=4, IO=3E8h; IRQ=3, IO=2E8h; IRQ=4, IO=2E8h;
IRQ=3

Serial Port B IO=2F8h; IRQ=3 Disable, IO=3F8h; IRQ=4, IO=3F8h; IRQ=3, IO=2F8h; IRQ=4,
IO=3E8h; IRQ=4, IO=3E8h; IRQ=3, IO=2E8h; IRQ=4, IO=2E8h;
IRQ=3

Parallel Port IO=378h; IRQ=7;
DMA=3

Disable, IO=378h; IRQ=7; DMA=1, IO=278h; IRQ=7; DMA=1,
IO=278h; IRQ=7; DMA=3, IO=3BCh; IRQ=7; DMA=1, IO=3BCh;
IRQ=7; DMA=3

PCI SERR# Generation Enable Disable

PCI VGA Palette Snooping Disable Enable

Printer Mode EPP+ECP Bi-Directional, Output-Only

Num Lock State at Power-
On

On Off

Integrated Graphics Auto Disable, Force

UMA Frame Buffer Size 512M 32M, 64M, 128M, 256M, 1G

Multi-Processor Enable Disable

Integrated Audio Enable Disable

Internal Speaker Enable Disable

NIC Option ROM
Download

PXE Disable
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B Diagnostics and Troubleshooting

LEDs

Table B-1  Power and IDE Flash Activity LEDs

LED Status

Power LED Off When the unit is plugged into the wall socket and the Power LED is off, the unit is powered off.
However, the network can trigger a Wake On LAN event in order to perform management
functions.

Power LED On Displays during boot sequence and while the unit is on. During boot sequence, hardware
initialization is processed and startup tests are performed on the following:

● Processor initialization

● Memory detection and initialization

● Video detection and initialization

NOTE: If one of the tests fails, the unit will simply stop, but the LED will stay on. If the video test
fails, the unit beeps. There are no messages sent to video for any of these failed tests.

NOTE: After the video is initialized, anything that fails will have an error message.

NOTE: RJ-45 LEDs are located inside the RJ-45 connector on the top, rear panel of the thin client. The LEDs are visible when
the connector is installed. Blinking green indicates network activity, and amber indicates a 100MB speed connection.

IDE LED is Off When the unit is powered on and the flash activity light is off, then there is no access to the
system flash.

IDE LED blinks white Indicates the system is accessing the internal IDE flash.
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Wake-on LAN
Wake-on LAN (WOL) allows a computer to be turned on or resumed from sleep or hibernation state by
a network message. You can enable or disable WOL in Computer Setup using the S5 Maximum
Power Savings setting.

To enable or disable WOL:

1. Turn on or restart the computer.

2. Press either Esc or F10 while the “Press the ESC key for Startup Menu” message is displayed at the
bottom of the screen.

NOTE: If you do not press Esc or F10 at the appropriate time, you must restart the computer and
again press Esc or F10 when the monitor light turns green to access the utility.

3. If you pressed Esc, press F10 to enter Computer Setup.

4. Navigate to Power > Hardware Power Management.

5. Set S5 Maximum Power Savings as follows:

● Disable WOL = Enabled

● Enable WOL = Disabled

6. Press F10 to accept any changes.

7. Select File > Save Changes and Exit.

Power-On Sequence
At power-on, the flash boot block code initializes the hardware to a known state, then performs basic
power-on diagnostic tests to determine the integrity of the hardware. Initialization performs the
following functions:

1. Initializes CPU and memory controller.

2. Initializes and configures all PCI devices.

3. Initializes VGA software.

4. Initializes the video to a known state.

5. Initializes USB devices to a known state.

6. Performs power-on diagnostics. For more information, see “Power-On Diagnostic Tests”.

7. The unit boots the operating system.
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Resetting the Setup and power-on Passwords
You can reset the Setup and Power-on passwords as follows:

1. Turn off the computer and disconnect the power cord from the power outlet.

2. Remove the side access panel and the metal side cover.

3. Remove the password jumper from the system board header labeled PSWD/E49.

4. Replace the metal side cover and the side access panel.

5. Connect the computer to AC power, and then turn on the computer.

6. Turn off the computer and disconnect the power cord from the power outlet.

7. Remove the side access panel and the metal side cover.

8. Replace the password jumper.

9. Replace the metal side cover and the side access panel.

Power-On Diagnostic Tests
The Power-on diagnostics performs basic integrity tests of the hardware to determine its functionality
and configuration. If a diagnostic test fails during hardware initialization the unit simply stops. There
are no messages sent to video.

NOTE: You may try to restart the unit and run through the diagnostic tests a second time to confirm
the first shutdown.

The following table lists the tests that are performed on the unit.

Table B-2  Power-On Diagnostic Test

Test Description

Boot Block Checksum Tests boot block code for proper checksum value

DRAM Simple write/read pattern test of the first 640k of memory

Parallel Port Initiates the port’s driver and determines if the device is present

Serial Port Tests the serial port using simple port verification test to determine if ports are present

Timer Tests timer interrupt by using polling method

RTC CMOS battery Tests integrity of RTC CMOS battery

NAND flash device Tests for proper NAND flash device ID present
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Interpreting POST Diagnostic Front Panel LEDs and
Audible Codes

This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.

WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.

NOTE: Recommended actions in the following table are listed in the order in which they should be
performed.

Not all diagnostic lights and audible codes are available on all models.

Table B-3  Diagnostic Front Panel LEDs and Audible Codes

Activity Beeps Possible Cause Recommended Action

White Power LED On. None Computer on. None

White Power LED flashes every
two seconds.

None Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the mouse
to wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

2 Processor thermal
protection activated:

A fan may be blocked or
not turning.

OR

The heat sink/fan
assembly is not properly
attached to the processor.

OR

The unit has vents blocked
or is in a location where
the ambient temperature is
too high.

1. Ensure that the computer air vents are not
blocked and the processor cooling fan is
plugged in and running, if equipped.

2. Contact an authorized reseller or service
provider.
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Table B-3  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

4 Power failure (power
supply is overloaded).

OR

The incorrect external
power supply adapter is
being used on the unit.

1. Check if a device is causing the problem by
removing ALL attached devices. Power on
the system. If the system enters the POST,
then power off and replace one device at a
time and repeat this procedure until failure
occurs. Replace the device that is causing
the failure. Continue adding devices one at
a time to ensure all devices are functioning
properly.

2. Replace the power supply.

3. Replace the system board.

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

5 Pre-video memory error. CAUTION: To avoid damage to the memory
modules or the system board, you must unplug the
computer power cord before attempting to reseat,
install, or remove a memory module.

1. Reseat memory modules.

2. Replace memory modules one at a time to
isolate the faulty module.

3. Replace third-party memory with HP
memory.

4. Replace the system board.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

6 Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card.

2. Replace the graphics card.

3. Replace the system board.

For systems with integrated graphics, replace the
system board.
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Table B-3  Diagnostic Front Panel LEDs and Audible Codes (continued)

Activity Beeps Possible Cause Recommended Action

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

8 Invalid ROM based on
bad checksum.

1. Reflash the system ROM with the latest BIOS
image using the BIOS Recovery procedure.

2. Replace the system board.

System does not power on and
LEDs are not flashing.

None System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns white, the
power button is working correctly. Try the
following:

1. Remove the power cord from the computer.

2. Open the computer and press the yellow
CMOS button on the system board for 4
seconds (located near the front USB ports).

3. Verify that the AC cord is plugged into the
power supply.

4. Close the unit and reattach the power cord.

5. Try to power on the computer.

6. Replace the unit.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

NOTE: The computer will beep once after a POST text message is displayed on the screen.

Table B-4  Numeric Codes and Text Messages

Control panel message Description Recommended action

103-System Board Failure DMA or timers. 1. Clear CMOS.

2. Remove expansion boards.

3. Replace the system board.

110-Out of Memory Space for Option ROMs Recently added PCI expansion card contains
an option ROM too large to download
during POST.

1. If a PCI expansion card was recently
added, remove it to see if the problem
remains.

2. In Computer Setup, set Advanced >
Device Options > NIC PXE Option
ROM Download to DISABLE to
prevent PXE option ROM for the internal
NIC from being downloaded during
POST to free more memory for an
expansion card's option ROM. Internal
PXE option ROM is used for booting
from the NIC to a PXE server.

161-Real-Time Clock Power Loss Invalid time or date in configuration memory.

RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

164-MemorySize Error Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.

201-Memory Error RAM failure. 1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3. Remove and replace the identified
faulty memory module(s).

4. If the error persists after replacing
memory modules, replace the system
board.

214-DIMM Configuration Warning Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.
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Table B-4  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

510-Flash Screen Image Corrupted Flash Screen image has errors. Reflash the system ROM with the latest BIOS
image.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

1. Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

513-Front Chassis fan not detected Front chassis fan is not connected or may
have malfunctioned.

1. Reseat front chassis fan.

2. Reseat fan cable.

3. Replace front chassis fan.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.

921-Device in PCI Express slot failed to
initialize

There is an incompatibility/problem with this
device and the system or PCI Express Link
could not be retrained to an x1.

Try rebooting the system. If the error
reoccurs, the device may not work with this
system

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1. Determine if hard drive is giving correct
error message. Run the Drive Protection
System test using F2 Diagnostics.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3. Back up contents and replace hard
drive.

Invalid Electronic Serial Number Electronic serial number is missing. Enter the correct serial number in Computer
Setup.
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Table B-4  Numeric Codes and Text Messages (continued)

Control panel message Description Recommended action

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing
pins.

3. Ensure that none of the keys are
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic utilities.

Troubleshooting

Basic Troubleshooting

If the thin client is experiencing operating problems or will not power on, review the following items.

Table B-5  Power-On Troubleshooting

Issue Procedures

The thin client unit is experiencing
operating problems.

Ensure that the following connectors are securely plugged into the thin client unit:

● Power connector

● Keyboard

● Mouse

● Network RJ-45 connector

● Monitor

The thin client unit does not power on. 1. Verify that the power supply is good by installing it on a known working
unit and testing it. If the power supply does not work on the test unit,
replace the power supply.

2. If the unit does not work properly with the replaced power supply, have the
unit serviced.

The thin client unit powers on and displays
a splash screen, but does not connect to
the server.

1. Verify that the network is operating and the network cable is working
properly.

2. Verify that the unit is communicating with the server by having the System
Administrator ping the unit from the server:

◦ If the thin client pings back, then the signal was accepted and the unit
is working. This indicates a configuration issue.

◦ If the thin client does not ping back and the thin client does not
connect to the server, re-image the unit.
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Table B-5  Power-On Troubleshooting (continued)

No link or activity on the network RJ-45
LEDs or the LEDs do not illuminate blinking
green after powering on the thin client unit.
(The network LEDs are located inside the
RJ-45 connector on the top, rear panel of
the thin client. Indicator lights are visible
when the connector is installed.)

1. Verify that the network is not down.

2. Make sure the RJ-45 cable is good by installing the RJ-45 cable onto a
known working device—if a network signal is detected then the cable is
good.

3. Verify the power supply is good by replacing the power cable to the unit
with a known working power supply cable and testing it.

4. If network LED's still do not light and you know the power supply is good,
then re-image the unit.

5. If network LED’s still do not light, run the IP configuration procedure.

6. If network LED’s still do not light, have the unit serviced.

A newly connected unknown USB
peripheral does not respond or USB
peripherals connected prior to the newly
connected USB peripheral will not complete
their device actions.

An unknown USB peripheral may be connected and disconnected to a running
platform as long as you do not reboot the system. If problems occur, disconnect
the unknown USB peripheral and reboot the platform.

Video does not display. 1. Verify that the monitor brightness is set to a readable level.

2. Verify the monitor is good by connecting it to a known working computer
and ensure its front LED turns green (assuming the monitor is Energy Star
compliant). If the monitor is defective, replace it with a working monitor and
repeat testing.

3. Re-image the thin client unit and power on the monitor again.

4. Test the thin client unit on a known working monitor. If the monitor does not
display video, replace the thin client unit.
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Diskless (No-Flash) Unit Troubleshooting

This section is only for those units that do not have ATA Flash capability. Because there is no ATA Flash
in this model the boot priority sequence is:

● USB device

● PXE

1. When the unit boots, the monitor should display the following information:

Table B-6  Diskless Unit Troubleshooting

Item Information Action

MAC Address NIC portion of the system board is
OK

If no MAC Address, the system board is at fault. Contact
the Call Center for service.

GUID General system board information If no GUID information, the system board is at fault and
should be replaced.

Client ID Information from server If no Client ID information there is no network
connection. This may be caused by a bad cable, the
server is down, or a bad system board. Contact the Call
Center for service for the bad system board.

MASK Information from server If no MASK information there is no network connection.
This may be caused by a bad cable, the server is down,
or a bad system board. Contact the Call Center for
service for the bad system board.

DHCP IP Information from server If no DHCP IP information there is no network
connection. This may be caused by a bad cable, the
server is down, or a bad system board. Contact the Call
Center for service for the bad system board.

If you are running in an Microsoft RIS PXE environment go to step 2.

If you are running in a Linux environment go to step 3.

2. If you are running in a Microsoft RIS PXE environment press the F12 key to activate the network
service boot as soon as the DHCP IP information appears on the screen.

If the unit does not boot to the network the server is not configured to PXE.

If you missed the F12 cue, the system will try to boot to the ATA flash that is not present. The
message on the screen will read: ERROR: Non-system disk or disk error. Replace and
press any key when ready.

Pressing any key will restart the boot cycle.

3. If you are running in a Linux environment an error message will appear on the screen if there is no
Client IP. ERROR: Non-system disk or disk error. Replace and press any key when
ready.
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Configuring a PXE Server
NOTE: All PXE software is supported by authorized service providers on a warranty or service
contract basis. Customers that call the HP Customer Service Center with PXE issues and questions
should be referred to their PXE provider for assistance.

Additionally, refer to the following:

– For Windows 2008 R2: http://support.microsoft.com/kb/891275

– For Windows 2012: http://technet.microsoft.com/en-us/library/cc766320(WS.10).aspx

The services listed below must be running, and they may be running on different servers:

1. Domain Name Service (DNS)

2. Remote Installation Services (RIS)

NOTE: Active Directory DHCP is not required, but is recommended.
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C Restoring the Flash Image

System Requirements
To create a recovery device for the purpose of reflashing or restoring the software image on the ROM,
you will need the following:

● A personal computer running Microsoft Windows XP Professional or Windows 7.

● One or more HP t620 Flexible Thin Clients

● 8-GB USB flash device for Microsoft Windows Embedded Standard 7 (WES 7) (if using the USB
format) or Linux.

This restore method will not work with all USB flash devices. USB flash devices with
multiple partitions generally do not support this restore method. The range of USB flash devices
available on the market is constantly changing. Not all USB flash devices have been tested with
the HP Thin Client Imaging Tool.

Before using the utility, you must download the appropriate image from http://www.hp.com.

Getting Started
There are two deployment options supported by this utility. You can choose to do one or more of the
following using your personal computer:"

● Create a bootable flash image on a USB flash device.

● Unbundle the image to a directory for use in a custom deployment scenario or PXE image.

Download and run the Package-for-the-Web deliverable (an .exe file) that contains the original factory
image for the thin client. The HP Thin Client Imaging Tool (CRStart.exe) runs automatically.

Choose one of the deployment options: Each option is described in the following paragraphs.

● USB Format

● Deployment

During the restore process, the thin client flash drive will be reformatted and all data
on it will be erased before the system image is copied to it. To prevent loss of data,
be sure that you have saved any user-created data from the flash drive. During the
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first restart of the thin client following the restore process, it may take approximately
15 minutes to unbundle the software before the Windows Desktop is displayed.

Formatting a USB Flash Drive
CAUTION: To prevent loss of data, be sure that you have saved any user-created data from the USB
drive to another drive.

1. Connect your USB flash device (drive key) to your personal computer. Ensure that only one USB
flash device is connected to the system.

2. Click USB Format.

3. Select the USB drive from the list, using the up and down arrows to display the correct drive letter.
(If the USB drive does not appear in the list, click Update Drives, then scroll through the list
again.)

During the next step, the USB drive will be reformatted and all data on it will be erased before the
bootable image is copied to it. To prevent loss of data, be sure that you have saved any data from
the USB drive to another drive.

4. Click Format. Connect the bootable USB flash device to the thin client. Only one bootable USB
device may be attached to the thin client during this process.

NOTE: Do not use USB 3.0 devices.

5. Restart the thin client.

6. When prompted Do you want to continue? [Y/N] click Y to begin the image restore process
on the thin client.

Unpacking the Image and Tools for Deployment
▲ Click Deployment.

The components that comprise the thin client recovery image (DSKIMG.BIN) are unbundled.

When this process is complete, the four most important files include: IBRPE.EXE (the image restoration
utility), FLASH.IBR (the OS image), the ReadMe.TXT file, and boot.wim (the pre-install environment).

NOTE: Linux uses the file name FLASH.DD while other operating system images use FLASH.IMG
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Deploying with PXE
1. Ensure that IBRPE.EXE and FLASH.IBR file exist.

2. Add the following command to execute IBRPE in WinPE environment: [full path]
\IBRPE.EXE [full path]\FLASH.IBR HD0

To view the IBR command line options: At the command prompt, type IBR.EXE /? and press Enter.

See your documentation if using a different PXE server, such as Altiris Deployment Solution.
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D Device management

The t620 includes a license for HP Device Manager and has a Device Manager agent pre-installed. HP
Device Manager is a thin client optimized management tool used to manage the full life cycle of HP
thin clients to include Discover, Asset Management, Deployment and Configuration. For more
information on HP Device Manager, please visit www.hp.com/go/hpdm.

If you wish to manage the t620 with other management tools such as Microsoft SCCM or LANDesk, go
to www.hp.com/go/clientmanagement for more information.
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E Adding an Image Restore Tool

1. Ensure that the boot order is set to use the Network as the first boot device.

2. Ensure that IBR.exe (Image Restore) and Flash.dd are stored in the same directory on the server.
(e.g., c:\program files\altiris\express\deployment server\images)

3. From the Altiris Deployment Server Console, click File > New > Job .

4. Enter a unique name for the job that you will use to deploy the original thin client image.

5. Click the name of the new job.

6. Near the upper right side of the screen, click Add.

7. Select Run Script from the menu.

8. Type [full path]images\ibr\exe-y\images\flash.xx hd0

NOTE: Linux uses the file name FLASH.DD while other operating system images use FLASH.IMG

9. Under In which OS would you like to run this script? Click DOS.

10. Click Finish.

11. You can now drag and drop the job onto the appropriate machine(s) or schedule it to run later,
depending on your needs. Refer to the documentation for Altiris Deployment Solution
(http://www.altiris.com/support/documentation) for more detailed information.
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F System BIOS

Updating or restoring a BIOS
HP Device Manager

HP Device Manager can be used to update the BIOS of a thin client. Customers can use a pre-built
BIOS add-on or can use the standard BIOS upgrade package along with an HP Device Manager File
and Registry template. For more information on HP Device Manager File and Registry templates, review
the HP Device Manager User Guide found at www.hp.com/go/hpdm.

Windows BIOS Flashing

You can use the BIOS Flash Update SoftPaq to restore or upgrade the system BIOS. Several methods
for changing the BIOS firmware stored on your computer are available.

The BIOS executable is a utility designed to flash the System BIOS within a Microsoft Windows
environment. To display the available options for this utility, launch the executable file under the
Microsoft Windows environment.

You can run the BIOS executable with or without the USB storage device. If the system does not have a
USB storage device installed, the BIOS update will perform under the Microsoft Windows environment
and followed by system reboot.

Linux BIOS Flashing

You can use the hp-flash utility and its associated driver to update the BIOS on systems running Linux.
After the driver loads, execute the utility from a command prompt with administrator privileges. The HP
ThinPro or HP Smart Client Linux OS images include the utility for updating the BIOS, but the binary file
to flash must be copied from the DOS Flash folder to the unit. Review the README.txt file for more
specific instructions in the SoftPaq. The Linux Flash folder also contains the files necessary to build the
BIOS flash driver module for the particular kernel being used; the hp-flash utility is not kernel-dependent
other than the choice of 32-bit (i686) and 64-bit (x86_64) flavors.

BitLocker Drive Encryption / BIOS Measurements

If you have Windows BitLocker Drive Encryption (BDE) enabled on your system, we recommend that
you temporarily suspend BDE before updating the BIOS. You should also obtain your BDE recovery
password or recovery PIN before suspending BDE. After the you flash the BIOS, you can resume BDE.

To make a change to BDE, select Start > Control Panel > BitLocker Drive Encryption, click
Suspend Protection or Resume Protection and then click Yes.
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As a general rule, updating the BIOS will modify measurement values stored in the Platform
Configuration Registers (PCRs) of the system's security module. Temporarily disable technologies that
use these PCR values to ascertain platform health (BDE is one such example) prior to flashing the BIOS.
Once you update the BIOS, re-enable the functions and restart the system so that you can take new
measurements.

BootBlock Emergency Recovery Mode

In the event of a failed BIOS update (for example if power is lost while updating), the System BIOS may
become corrupted. BootBlock Emergency Recovery Mode detects this condition and automatically
searches the root directory of the hard drive and any USB media sources for a compatible binary
image. Copy the binary (.bin) file in the DOS Flash folder to the root of the desired storage device, and
then power on the system. Once the recovery process locates the binary image, it attempts the recovery
process. The automatic recovery continues until it successfully restores or updates the BIOS. If the system
has a BIOS Setup password, you may need to use the Startup Menu / Utilities submenu to flash the
BIOS manually after providing the password. Sometimes there are restrictions on which BIOS versions
are allowed to be installed on a platform. If the BIOS that was on the system had restrictions, then only
allowable BIOS versions may be used for recovery.
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G Power cord set requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC.
Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General requirements
The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.

WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese power cord requirements
For use in Japan, use only the power cord received with this product.

CAUTION: Do not use the power cord received with this product on any other products.
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Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency  Country Accrediting Agency

Australia (1)

Austria (1)

Belgium (1)

Canada (2)

EANSW

OVE

CEBC

CSA

 Italy (1)

Japan (3)

Norway (1)

Sweden (1)

IMQ

METI

NEMKO

SEMKO

Denmark (1)

Finland (1)

France (1)

Germany (1)

DEMKO

SETI

UTE

VDE

 Switzerland (1)

United Kingdom (1)

United States (2)

SEV

BSI

UL

1. The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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H Statement of Volatility

Thin Client products typically have three types of memory devices namely, RAM, ROM, and Flash
memory devices. Data stored in the RAM memory device will be lost once the power is removed from
the device. RAM devices could be powered by main, aux, or battery power (power states are
explained below). Therefore, even when the unit is not connected to an AC outlet, some of the RAM
devices could be powered by battery power. Data stored in the ROM or Flash memory devices will
retain its data even if the power is removed to the device. Manufacturers of Flash device usually specify
a period of time (in the order of 10 years) for data retention.

Definition of power states:

Main Power: Power available when the unit is turned on.

Aux or Standby power: Power available when the unit is in off state when the power supply is
connected to an active AC outlet.

Battery Power: Power from a coin battery present in the Thin Client systems.

The table below lists the available memory devices and their types per the models. Please note that the
Thin Client systems do not use traditional hard drives with moving parts. Instead, they use flash memory
devices with an IDE front end interface. Hence, the operating systems interface with these flash devices
similar to a regular IDE hard drive. This IDE flash device contains the image of the operating system.
The flash device can only be written by an administrator. A special software tool is required to format
the flash devices and clear the data stored in them.

Please find below a list of steps that should be taken to update BIOS and use it to set the BIOS settings
to factory default settings.

1. Download the latest BIOS (system ROM) from the HP website.

2. Follow the instructions to flash the BIOS that are found on the website.

Flashing the BIOS will reset it back to factory settings.

3. Turn on the system, and while system is powering on, and after the HP splash screen, press the
F10 key to enter BIOS setup screen.

4. Set defaults and exit (this will clear passwords and any other settings)
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Model Description Location/Size Power Loss of data Comments

t620, t620 PLUS

System Boot ROM
(BIOS)

SPI ROM (64 Mbit)
socketed,
removable.

   

System memory
(RAM)

SODIMM socket.
Removable (4GB/
8GB)

Main power If main power is
removed

Only S0/S3/S5/
G3 ACPI states are
supported

RTC (CMOS) RAM RTC RAM is 256
bytes RAM
Memory
embedded in AMD
APU’s System on
Chip (SOC).

Main/battery If battery power is
removed

 

Keyboard/mouse
(ROM)

RTC RAM is 256
bytes RAM
Memory
embedded in AMD
APU’s System on
Chip (SOC). 2k
bytes embedded in
the super I/O
controller (SIO12)

Main   

Keyboard/mouse
(RAM)

256 bytes
embedded in the
super I/O
controller (SIO12)

Main If main power is
removed

 

LOM EEPROM LOM EEPROM
256 bytes
embedded in LAN
Chip.

SUS  One Time
programmable
memory (OTP)

TPM 6 kBytes
embedded in TPM
Chip. It’s ROM for
TCG Firmware

Main   

The information contained herein is subject to change without notice.

The only warranties for HP products and services are set forth in the express warranty statements
accompanying such products and services. Nothing herein should be construed as constituting an
additional warranty. HP shall not be liable for technical or editorial errors or omissions contained
herein.

If you require additional information or need assistance please contact James Smalls at 281-514-5723.
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I Specifications

Dimensions

Width: HP t620 Thin Client

Width: HP t620 PLUS Thin Client

Depth

Height (without stand)

Height (with stand)

40 mm

65 mm

240 mm

219.70 mm

220 mm

1.57 in.

2.56 in.

9.45 in

8.65 In

8.66 in.

Temperature Range (fanless design)*

Operating**

With the fiber NIC is installed

(max. rate of change is 10°C per hour or 18°F per hour)

Nonoperating

(max. rate of change is 20°C per hour or 36°F per hour)

10°C to 40°C

10°C to 35°C

-30°C to 60°C

50°F to 104°F

50°F to 95°F

-22°F to 140°F

*Specifications are at sea level with altitude derating of
1°C/300 m (1.8°F/1000 ft) to a maximum of 3 Km
(10,000 ft), with no direct, sustained sunlight. Upper limit
may be limited by the type and number of options installed.

** The operating temperature range when the thin
client is attached to a flat panel using the HP Quick
Release is 10°C to 35°C (50°F to 95°F).

Relative Humidity (non-condensing)

Operating

(max. wet bulb temperature is 28°C or 84.2°F)

Nonoperating

(max. wet bulb temperature is 38.7°C or 101.6°F)

10% to 90%

5% to 95%
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Maximum Altitude (unpressurized)

Operating

(max. allowed rate of change is 457m per minute or 1500
ft per minute)

Nonoperating

(max. allowed rate of change is 457m per minute or 1500
ft per minute)

3048 m

9144 m

10,000 ft

30,000 ft

Power Supply

Operating Voltage Range

Rated Line Frequency

HP t620 Thin Client

100 VAC to 240 VAC

50 Hz to 60 Hz

HP t620 PLUS Thin Client

100 VAC to 240 VAC

50 Hz to 60 Hz

Power Output (maximum) 65 W 85 W

Rated Output Current (maximum) 3.33 A 4.36 A

Output Voltage +19.5 V dc +19.5 V dc
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